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REVISIONS

06/08/2007 – SHEET 3-9 - Added a new sheet to the document Sheet 3-9

06/18/2007 – SHEET 3-8 & 3-9 - Added a section on various attachment methods for referencing files

06/18/2007 – SHEET 3-20 thru 3-22 - Added steps for the creation of the Limits of Construction

06/18/2007 – SHEET 4-21 thru 4-23 - Added three new sheets on Data Cleanup

06/28/2007 – SHEET 3-28 – Edited the note at the top of the page 

06/28/2007 – SHEET 3-29 – Deleted Step 5

06/28/2007 – SHEET 6-1 – Added a common fix for an Iplot Organizer plotting issue
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Chapter 1 :  TIP Folder Structure

Folder Structure

· All TIP projects will have the following standard folder structure (except for a few old projects that are still around).  

These folders are named according to their usage and the table below summarizes the TIP root sub-folder names. 
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TIP Root Folder Structure

To establish uniformity among PEF's and Highway Design Units, all electronic subrnittals shall comform o a standard folder structure.
‘These folders are named according to their usage. The table below summarizes the TIP root sub-folder names.

Folder for 2 sub-folders: Transmittals and MieStones. The Transmittals folder contain transmittal documents between the various units. The MileStanes folder
Common will not be used for the time being, and should be ignored. It has been placed there to accommodate future document management systems. All DOT and DO
domain users have "Read” and "Wodiy” permissions for this folder.

Folder for “cim"fles from the Hydraulics unit,

Risingse Note: The files in this folder should only be modified by the Hydraulics or Roadway Design units.
Folder for *ctrm"fles from hoth the Location Surveys and Photogramrmetry urts

] Note: The files in this folder should only be modified by the Location Surveys and Phatogrammetry units. Other units should only reference ther as iswithin this
Tolder.

Environmental | Folder for fles and documents and plans that pertain to environrmental issues, used primariy by the Roadside Environmental Uit

Geotech Folder for Geotech design files

_ Folder for gp# fles. Each gpk fle should have  unigue unitcoge to prevent coruption of data
See GPKFle Conventions

Hydraulics Folder for Hydraulics desion files

LightingElectrical || Folder for Lighting & Electrical design files.

Folder for Location Surveys files such as i, dim, or pin.
LocationSurveys || Note: The files in this folder should only be mocified by the Lacation Surveys unit. Other units may capy the files from this folder to another folder and then
modifythem, o reference them s is from within this folder

Folder for files and documents related to aerial photography, topographic, planimetric and cadasiral maps, base plan sheets, and preliminary cross-sections,
aerial mosaics and photo plan sheets for highway design. These fles follow the same format as the Location Surveys fles

Note: The files inthis folder should only be modified by the Photogrammetry unit Other units may copy the files from this folder to another folder and then moiy
thern, or reference them a s from wihin this folger.

Photogrammeic

Folder for fles and documents related to or necessary for acauisiion of all necessary lands and rights of way used for highway construction. A "snap shot' of

Rightofay the RoWW plans will be placed here (and ll subsequent RoW revisions) when  project s sentto Row.

Roadway Roanway Folder Structure

Stuctures Folder for fles and documents related fo structure design: bridges, culverts ste.

-~ Folder for fles and docurnents related to general Traffc Engineeting issues (including raffic control, paverment markings and delineation, signalization, and
signing) are cortained here.

Uities Folder for fles and docurnents felated to Utiity Desion are cortained here

WetLand Folder for Enviranmental Document and PDBEA lssues.





· The following subfolders are under the Roadway folder and are for use by Roadway Design:

[image: image10.emf] AutoTurn

DGN file of Intersection examined 

Autoturn Analysis Reports 

The simulation files (SIM) are stored in C:\winn32app\Autoturn\output folder.  A copy of these files is placed in the AutoTurn folder to be recorded and keep with the TIP Project. 
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Capacity
HCS Analysis Reports 

[image: image12.emf]
Doc
Project Correspondence 

Project Transmittals 

Design Exception Check List 

Approved Project Design Criteria Check List 

CADD Project Log Sheets (DOC) 

COGO Chains and Profiles Text Log Ouput Files (LOG) 

[image: image13.emf]Estimate
Earthwork Balance Card 

Estimates XLS spreadsheets 

Estimates DGN Shape Files 

Estimates Reports (Curb & Gutter and Seeding and Mulching) 

Quantity Manager PDF files 

SAPW Estimates (Consultant Only) 
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Func
All Relevant Files in Functional Phase of Plan Composition. Please note that all relevant sub-folders can be created by Roadway.
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PHM Files 

PDF Hearing Map Files 

All Reference PHM Shape Files 
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iFiles
Full Size and Half Size iPlot Organizer IPS Files 

i Files 

PHM iPlot Organizer IPS Files 

[image: image17.emf]Inp
Geopak COGO Input Files ONLY 
See XSC folder for recommended location for earthwork and criteria input files.
Maximum file name length saved is limited to five (5) characters in the Geopak File Utilities Dialog Box. 

Maximum file name length displayed is limited to eight (8) characters in the Geopak File Utilities Dialog Box. 

Maximum file name length saved (and resave) is limited to 64 characters in the Geopak COGO key-in field. 
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Project Picture Files

[image: image19.emf]Proj

ROADWAY ORIGNAL FILES

DSN DGN Files 

PFL DGN Files 

PSH DGN Files 

ROW DGN Files 

ROW Parcel Index DGN File 

ROW Parcel Index XLS File 

SPD (SHEAR POINT DIAGRAM) DGN Files 

Structure Recommendation DGN Files 

SUM DGN Files 

SUMMARY XSL Files 

Survey Request DGN Files 

TSH DGN Files 

TYP DGN Files 

COPIED FILES FROM OTHER UNITS

BLN DGN Files 

BRL DGN Files 

ELN DGN Files 

PLN DGN Files 

SUE DGN Files 

TOP DGN Files 

WET DGN Files 

[image: image20.emf]
Wedging
Back-up (*.b0*) Wedging Files (Maybe deleted) 
PAR Wedging Files (Project Station Files) 
PRF Wedging Files (NCWedge Preference Files) 
GRD Wedging Files (NCWedge Grade Files) 
WQF Wedging Files (Wedging Quantity Files) 
COPIED FILES

EOP DGN Files 

GPK Files 

SHP DGN Files 

XSC DGN Files 
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XSC
Criteria Input Files 

Cross Section Sheet 1A XSL File 

EOP DGN Files (ORIGINAL) 

Earthwork Input Files 

Earthwork Report 

SHP DGN Files (ORIGINAL) 

Superelevation Input Files 

XPL DGN Files 

XSC DGN Files (ORIGINAL) 

· More information and examples of file types and the information found in each folder can be located on the Roadway Design web site at:      

·                                                                       http://www.ncdot.org/doh/preconstruct/highway/roadway/index/folders/folder_str.html#ca
File Naming Convention

MicroStation CADD Files

The following Design File Naming Convention is implemented on all new projects. This naming convention is to be used by all NCDOT users and private engineering firms who produce TIP plans. Because of conflicts that have occurred with other applications, all design files will have the extension of DGN. This is the Bentley MicroStation assigned extension.

The following format is for all new design files:

(TIP Number)_(Unit Abbreviation)_(File Type)_(Description).dgn 

for example: 

R2005BA_RDY_DSN_070424.dgn 

Where:

· TIP Number is the Transportation Improvement Program assigned number. 

· Unit Abbreviation is the assigned Unit Code. 

· File Type describes the information in the file. (Property, Design, ROW, etc.) 

· (Optional) Description is a user defined variable. (If a date is used, the format is year, month, day. A data of 070424 would be April 24, 2007) 
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The Design File Generator Program (Discussed in Next Chapter) can be found in the NCDOT Workspaces in the following directory.

C:\NCDOT_V8_WORKSPACE\NCDOT_STDS\Standards\appl\

GEOPAK GPK Files

Each Unit will name their GPK file beginning with the word "JOB" followed by the assigned Unit Code. 

for example: 

Roadway Design would name their GPK file "JOBRDY.GPK".

Chapter 2 :  Desktop Cadd Utilities

MapDrive  

[image: image23.emf]
The MapDrive application can be found in your application folder in the NCDOT workspace. It is recommended that you create a shortcut on your desktop for quick reference to this application. MapDrive reads the username.mapdrive.cfg file off of your U: drive (or C:\temp if your do not have a U: drive mapped). This file can be edited so that you can customize it for projects in your group. 

[image: image24.emf][image: image25.emf]
An advantage to MapDrive over SrvConn (described next) is that you can choose which drive you want to map through. While it is highly recommended to map through the R: drive, there can be times when you need to connect to multiple projects at the same time and MapDrive will allow you to do this. More information is available on Roadways website at:

http://www.ncdot.org/doh/preconstruct/highway/roadway/siteindex/rdu-mapdrive.html

[image: image26.emf]
SrvConn
The SrvConn application can be found in your application folder in the NCDOT workspace. It is recommended that you create a shortcut on your desktop for quick reference to this application. SrvConn is an application that will disconnect any current connections that you may have on the R: drive and re-connect to the TIP project you typed in. SrvConn is very quick and efficient though it will only allow you to connect to one project at a time. 

SrvConn also allows you to browse two folders called “NSProj” and “Proj” which stand for “Non-Standard Projects” and “Projects” which are standard.

[image: image27.emf]                      

NSProj




 
  Standard

[image: image28.emf][image: image29.emf]
The difference between these two are that as long as there are some older projects that do not follow the “Standard” folder naming convention, they will always be located in the “NSProj” folder. The reason for this is that folder permissions are applied for each unit as discussed earlier on each folder and that it is impossible to standardize older projects with hundreds of odd named folders.

Update Workspace

This application is used to update your MicroStation workspaces and should be done at least once a week. You will find this application at the following location:

“S:\Share\rd_InternalApplication\UpdateWorkspace\UpdateWS.exe” 

[image: image30.emf]A short cut should be added to your desktop. 

When started, the application looks like this:

Please note the highlighted workspaces.

NCDOT_STDS

NCDOT_V8_CONFIG

ROADWAY_STDS
These are the only workspaces needed for everyone in Roadway Design.

Also note the red exclamation mark  [image: image2.jpg]



and the check mark  [image: image3.jpg]



[image: image31.emf]If you have an exclamation mark  [image: image4.jpg]


 beside one of your workspaces, that means it is not up to date and a newer copy is available on the server. Click in the box beside the exclamation mark  [image: image5.jpg]


 and click on the “Update” button

You will need to be completely out of MicroStation to update your workspaces. After the application has updated everything you checked, the exclamation marks [image: image6.jpg]


 will change to a check mark [image: image7.jpg]
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Chapter 3 :  PLAN COMPOSITION

[image: image34.emf]Design File Generator

Design File Generator is an application that can be found in your application folder in the NCDOT workspace. This application will automatically name new design files for you w/o you having to remember all the rules and standards for file naming conventions. 

1. Insert the Tip Number
2. [image: image35.emf]Select the Unit
3. Select the File Type
4. Insert the Description
5. Select the Drive
6. Select Directory
7. Select  the Type of File Dimensions
8. Select  the Workspace
9. Shows You the New  Design File Name
10. Click Create to Store New Design File in the Desired Location (Note:  You can double click the file in the Files list to open it)
Exercise 1: Create the following Design Files in U2547 Roadway Proj folder: Plan Sheet Layout, Row, Slopestake, Design, Profile, in the Roadway XSC  folder create the following X-section for -Y- X-Section Layout (XPL)for -Y- and a pattern line file for -Y-.
Typical Section Generator
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[image: image75.emf]Finished Typical drawn with Typical Section Generator for Exercise 2

These dialog boxes were used to create the typical for the Exercise 2
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Referencing Design Files

Dialog Box Method
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Referencing File Models (Coincident, Coincident-World, and Interactive)

What is the recommended referencing method proposed by Roadway CADD Support?
Coincident World
What is the difference between Coincident, Coincident World, and Interactive Referencing?

coincident – attaching the referenced file Default model where its DESIGN PLANE ORIGIN is aligned with the master file model DESIGN PLANE ORIGIN. If there is a global origin difference between the two file models, then the referenced elements are not coordinately correct with respect to the master file model.

coincident world– attaching the referenced file Default model where its GLOBAL ORIGIN is aligned with the master file model GLOBAL ORIGIN. If there is a global origin difference between the two file models, then the referenced elements ARE coordinately correct with respect to the master file model.

(continued on Next page)

[image: image92.emf]
interactive – option to reference other models, not just the Default model. Coincident and Coincident world attachment methods will still have to be selected. Other options include the ability to key-in logical names and setting live nesting depths.

What is the referenced file model LOGICAL NAME used for?

For regular plan production, specific logical names for the referenced plannametric files will plot out light or shaded underneath the dark solid DSN and master PSH file models.
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Drag & Drop Method
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Draw A Profile Using Geopak Draw Profiles
PART I. Existing Ground Profile
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PART II.  Proposed Profile
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Draw An Alignment Using Geopak D&C Manager

[image: image136.png]‘Select Element
Select Al

Select Nore
Select By Atibutes
PoweiSelector





[image: image137.emf]
[image: image138.emf]
[image: image139.emf]
[image: image140.png]SHAPE SET
TYPE = CHP_SHAPE
Lvnane




[image: image141.emf]
[image: image142.emf]
[image: image143.emf]
[image: image144.emf]
[image: image145.emf]
[image: image146.emf][image: image147.emf]
[image: image148.emf][image: image149.emf][image: image150.emf][image: image151.emf]

Limits of Constructions
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Plan Sheet Layout
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Iplot Organizer-Plan Sheets
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Generate Existing Ground X-Sections Using Pattern Lines

[image: image237.png]



[image: image238.png]



[image: image239.png]Hik




[image: image240.png]


[image: image241.emf]
[image: image242.emf]
[image: image243.png]"> JEE

Harme.

Roadway Index
Wihats New (Roadway)

DOT Directory
STaRS (formery PMi))
DOTFTS

Manuals, Standards,
Checklist

NCDOTTIP.

Mermos & Winutes

Criteria Files
Roadway Dictionary
QgAFoum

Hearing Maps (PDF)
Other Unit Links

Software Versions
Intemal Use Dny
Calendar & Email




[image: image244.png]File Name:  LI2547_Rdy_tom.dan
FullPath: _..\Roadway!\Prai\LI2547_Re_tow.dan
Modet. [Defaul —

Logecal Name: [ow

Descipton: | Global Dign algned v asterFie

Orientatior:
Name. [ Description |
[Coincidert Aiigned wih Master i

 Digin algned wih Masiet il

Ton Standaid View

Scale (MasterRef) [T00000C + [T000000 ¥ Tiue Scale

Nested Attachments: _LiveNesting | Depth: [0

I¥' Display Raster References

Cancel ptons.





[image: image245.png][Boomeaiic N T ]
Fio 3 Upttncpons

sotintes 7S] g3 Lo 00000
L |

Dot
Prte e S
Vel Otz [T5000





[image: image246.png][Road" J

(|,

[t of Constructon|



[image: image247.png]= =loix]

wbld CuSte SS380R1

Chan[T | | Tokance [07500T
BegSta  9+9360R 1 [s+5380RT
EndSta  44450.00R 1 [as0m0RT

Plan Dan [FiRoadnayPronU2547_Rdy_ss.dar | Fies

Existing Ground Line __@E~ | Diggy

Proposed Finish Grade @0, | Disgay

Parameters Radis of Display [5.000000
Tie Down Option_Quter Tis Downs ¥

Aorly |




[image: image248.png]Existing Ground Line. % Display



[image: image249.png]| Beasting & =lolx|
| LyNames: [E4tc Growdlin | o
R e
R e
-
-

Styes: o
eights =

Display




[image: image250.emf][image: image251.emf]
[image: image252.emf]
[image: image253.emf]
[image: image254.png]



[image: image255.png][GEOPAK Set Feature

Symbology
Lol

Color [ Bylevel =]
Weight: [——— Bylevel x|

Test Preferences

“r il
Ft le
Desinat 0_|

Carce




[image: image256.png]Jil=i )

Cut Prefix [T S
FillPrefx [F S

4

By Current
Righ . By Element
RT Oriertation._Relative v [0 CoPY

LT Orientation_Reltive v [ [6_E222
AT Offset [T000000 LT Offset [T0.00000

o Carce







[image: image257.png]


[image: image258.png]s

7
4 s/

“;é, S

/[ cus st
Chan [T x| Tolence [0750000
/ BegSta 9:9360R1 [880RT
EndSia 40SO00R 1 K —

Flan Dan [T\Rosdnay\ProRUZ647_Rdy_ss.dan_Files

Existing Ground Line __@E~ | Diggy

Proposed Finish Grade __E~ | Disgay
Parameters Fadis of Dislay [ 5000000
TieDown Opton _Ouier TizDows

CL |

C,




[image: image259.png]attachment methods
referancing design planes {20} and design cubas (3D}

REFERENCED
. moda (design plane)

aligned referancad fls DESIGN PLANE ORIGIN wih
design plane origin ‘Mentor o DESIGN  PLANE ORIGIN

CONCIDENT WORD

NASTER REFEENCED
ol ey O T
i85 oS}

ofioed rafagnced fis GLOBAL ORIGIN
‘Master fis GLOBAL ORGIN'

design plane origin





[image: image260.png]=0l

el | [ Owoe] | s | G

cion

Dele

Element Types:

Match—————

T Color
™ Syle
™ Weight

™ UserData





[image: image261.png]Fie
Genosl | Duplostes

Process View: 1 ¥

I™ Create Backup

(5] e~
™ Save FlagsinFile

Flag Size: [T.0000

Overview

Ovetaps |

Cleanup Actons

Duplicates: _one
Overlaps: -none
Gaps: _-none

Gaps

#Found
NA

NA
NA

Duplicate: When 2 slemerts o the same type shte the same location and georety.

Ovetlap: When 2 elements partal overlap one another
Giap: When an slement hiss an endpoint too far from anclhe element

=

Design File Cleanup disiog box




[image: image262.png]Uities  workspace  Appiic
Key-n

Connect Web Browser
HIML Author

el selector
Inage »
Render »

Augiary Coordinates
Saved views
Named Graups

Batch Converter,
Batch Process.

Standards Checker >
packager.

archive

Generate Section

Instal Forts.

oG »
License Check Out/in

Macro »

ML Applications.



[image: image263.jpg]<3
24
g





[image: image264.png]


 
Generate Proposed X-Sections & XPL’s 





            Note:





















Iplot Organizer-XPL Sheets
















Chapter 4 :  ROADWAY TOOLS

RD_GRID

 

Step 1.

Open the U2547_rdy_pfl.dgn design file and place in Top View .





                    





              







RD_UserRotate 




Supplemental Attachment Tool Frame 


All Reference File Models Display Off/On


Shape Fill Display Toggle


Line Weight Display Toggle


DP in Same Location


Create Shape with Polygons

1. Place Block *

2. Place Shape

3. Place Orthogonal Shape

4. Place Regular Polygon

* When using the Place Block command, the two methods are Orthogonal and Rotated.


Orthogonal




Rotated




Create Complex Shape

(Manual Method)


STEP:

1. Evaluate the direction of outlining elements before creating the shape.

2. DP (1-3) on the outlining elements in the order determined. Note the gap between DP element 1 and 2 is automatically bridged with a line element.

3. DP (4) on the screen once to accept and right click on the mouse to complete the shape creation.

Note that outlining elements have to be in the active file model for this tool to work. The shape can not be created if the bounding elements are referenced. One of the advantages of this tool is that if a gap exists between two elements, then this tool will automatically bridge the gap with a line.

Simplify Geometry

This option determines if the shape created is be a Simple (Type 6) or Complex (Type 14) Shape. There is no advantage to selection one over the other. However, Roadway CADD Support for plotting purposes prefers having Simplify Geometry checked.   



Create Region

(Flood Area)




STEP:

1. Make sure all outlined boundaries are closed before creating the shape.

2. DP (1) anywhere inside the desired region to be “flooded”.

3. DP (2) on the screen once to accept and right click on the mouse to complete the shape creation.

Note if the Geopak D&C Manager RD_HearingMap.DDB is used to create shapes, by default the create region command is invoked. In contrary to the Create Complex Shape command, the outlining elements can be referenced or in the active file in order to create the shapes.

Keep Original
This option determines if the outlined elements used to create the shape is to be deleted after the shape has been created. Roadway CADD Support prefers having Keep Original checked initially. Once all the shapes have been created for the appropriate file model, then these outlined can be deleted. Use the select By Attributes tool to delete all elements except shape and complex shape elements for this. 

Select by Attributes

The Select by Attributes dialog box is used to select certain found in the active file model base on certain criteria. The following is from the Microstation Help file.

1. From the Edit menu, choose Select By Attributes. The Select By Attributes dialog box opens. The second option menu in the Mode section should be set to Selection.

2. (Optional) Use the controls in the dialog box to specify selection criteria. (To specify criteria based on element properties, click the Properties button and use the controls in the Select by Properties dialog box. To specify criteria based on tag values, click the Tags button and use the controls in the Select By Tags dialog box.)


3. In the Mode section, make sure On is chosen from the third option menu.


4. Click Execute.The elements meeting the specified selection criteria are highlighted.

The above procedure can be adapted for locating (highlighting) elements or filtering their display based on their attributes. The effect of the Execute button in the Select By Attributes dialog box is controlled with the second option menu in the Mode section, which is set to Selection by default. The other options are Location and Display.


Sometime it is desired to deselect certain elements or select all elements except for what meet the criteria. To accomplish this, change the Inclusive option to Exclusive option under the Mode setting.

Cross section Movie Navigator


1.  Job Number
After the application has been loaded, select the job number. This application searches for the GPK file in the Job (GPK) Directory set in the COGO preferences. 

*** NOTE: Depending on how many cross section cells are associated a particular chain, the process of selecting the Job number will also load other information, i.e. stations, and it may take up to one full minute. This is normal and do not attempt to end this process.
2.  XS Chain
After selecting the Job Number, the chain(s) found in the file is loaded into the XS Chain drop down combo box.

3.  Profile
As an option, if Profile is checked and the corresponding profile for that chain is selected, then the profile grade is used to the lock the view moving to and from cross section. If unchecked, default, then the green horizontal cross section cell line is used to the lock the view moving to and from cross sections. Ideal application is in mountainous projects, where drastic elevation differences are encountered moving from one cross section to the next.

4.  Station
If the correct Job Number and XS Chain is chosen, then the station list is populated. Navigation from one station to another can be done by three methods, the drop down station combo box, the DVD style buttons, or the automatic movie mode. 

5.  Fit XS To View button to reset the view to fit the cross section view to the width of the green cross section cell.

6.  Navigation
A very effective method of cross section navigation, the DVD style buttons, (1) First (2) Previous (3) Next (4) Last cross section can be used. Under Movie Mode, the Play Reverse, Play Forward, and the Stop buttons can also be used. The frame rate can also be set. Default is 2 frames per second, and it can be to a maximum of 32 frames per second. The higher the frame rate, the faster the movie plays from one cross section to the next.

Model Navigator




1.  View Option
· None - With the next model opened, no view intervention is applied. That view will be the last view area of model. 

· Fit - With the next model opened, that view will be "fitted" to screen of all graphical elements displayed. An example application of this view option is when navigating through cross section sheets (XPL). 

· Same - With the next model opened, that view will be same as the previous model view. An example application of this view option is if the DSN file is composed of many models, right of way, horizontal alignment, and slope stake. Navigating through these models will have the same view area as the previous model view. Similar to RD_AutoXD.

Three ways to navigate with the Model Navigator.  Automatic Mode







Sheet North Arrow Placement (SNAP)



1. Current Folder
After the application has been loaded, click on the Browse button to select the location of the folder where the plan sheet files (PSH) are. Notice the messages in the lower left corner that will guide you through the program.



2. Files In Folder
These are the list of Microstation DGN files found under the Current Folder selection.

3. Files To Process
Microstation DGN files to place the north arrow cell in. Mostly Roadway Plan Sheet files (PSH).

4. Move Selected Files for Processing 
Selected files in the Files In Folder list will be moved to the Files To Process list.

5. Move All Files for Processing 
All files in the Files In Folder list will be moved to the Files To Process list.

6. Remove Selected Files from Processing 
Selected files in the Files To Process list will be moved to the Files In Folder list.

7. Remove All Files from Processing 
All files in the Files To Process list will be moved to the Files In Folder list. 


8. NAD - North American Datum MSL Datum Year
North arrow cell to be placed.

      NAD83 (1983) 

      NAD27 (1927) 

      None (North arrow cell with no NAD designation) 

9. Project Scale
Determine the size of north arrow cells. Project scale is equivalent to plot scale at full size plan sheets (22"x34").

10. PSH Filter
Toggle to display only Roadway plan sheet (PSH) file type files in the Files In Folder list (i.e. R2007_RDY_PSH_S04.DGN).

11. GO
Process all the file in the Files To Process list in order. During processing, in the lower left corner of the screen, the stoups of the processing is displayed.







Microstation Status Bar

The following is from a Microstation help file:

The Microstation Status Bar provides prompts, context-sensitive assistance, and some interactive functionality. 

	 



Selected tool > prompt

Shows the name of the selected tool or view control and (usually) a prompt for the next step in the normal procedure for using it.

Message Center

Shows system message information. Clicking in the Message Center portion of the status bar opens the Message Center dialog box. This dialog box contains a running log of system messages and any further description about the message if applicable.

Snap mode

Shows the type of snap selected.

Clicking the Snap Mode field posts the pop-up Snap Modes menu. The effect is the same as pressing the Tentative button while holding down the <Shift> key.

Locks icon

Clicking the Locks icon provides access to the Locks submenu. (It does not indicate status information.) 

Active level

Shows the Active Level setting. 

Clicking the Active Level field opens the Level Manager dialog box, which is used to control level display and level symbology for the open DGN file and attached references.

Element selection indicator

If shown, indicates elements are selected and displays the number of selected elements.

	 

	

	
	



Clicking the status bar when it shows the number of selected elements opens a pop-up menu containing the following items:

	Pop-up menu item
	Choose to

	Select Element
	Select an elements in the active model.

	Select All
	Select all elements in the active model (effect is same as choosing Edit > Select All ).

	Select None
	Deselect all elements in the active file (effect is same as choosing Edit > Select None).

	Select By Attributes
	Open the Select By Attributes dialog box (effect is same as choosing Edit > Select By Attributes).

	PowerSelector
	Select PowerSelector.


Fence indicator

If shown, indicates the fence mode of the fence that was placed. To place the fence, use a fence placement tool in the Element Selection tool box.

DGN workmode

Indicates which workmode is in effect. In DWG (“DWG”) mode, certain functionality is disabled by default in order to restrict MicroStation to creating only information that can be stored in DWG format.

DGN file changes indicator

If a “diskette icon” is shown in the lower right-hand corner, it indicates that the DGN file has been modified during the current session. If the preference Automatically Save Design Changes is off, it indicates that there are changes that have not been saved. If the diskette is red and has an “X” through it, it means that the file is read-only.

Copy Level Name to Clipboard



Open the U2547_rdy_shp.dgn design file.








   


Centerline Coordinate List



Step 1.
Set Cogo Information









Designers can edit the Beginning and Endings Station fields by keying in the numeric station values and it will automatically reformatted to the station format. If a station entered is not within the selected chain, the beginning or ending station is entered in its place. Anytime the Designer wants to know the beginning and ending stations for a selected Chain, place the mouse pointer to the Beg Sta: or End Sta: label and then the station information is displayed.



Step 2.

Create Centerline Coordinate List 























Create Centerline Coordinate List Sheet





Data Cleanup

Data Cleanup - Microstation Help
The following is from a Microstation help file:

Design File Cleanup dialog box

Used to identify duplicate elements, overlapping elements and/or gaps between elements in the active design file.

Duplicate — two elements of the same type that share the same location and geometry.

Overlap — two elements that partially overlap one another.

Gap — when an element has an endpoint too far from another element.

Cleanup actions are performed via the Design File Cleanup dialog box. You can set the desired cleanup action(s) from the dialog box´s General tab, or you can go to each cleanup action´s individual tab and set the cleanup action as well as further restrict or expand the search criteria.

Some cleanup actions can be performed simultaneously. For example, you can instruct Design File Cleanup to select all Duplicates and flag all Overlaps at the same time. When running Interactive mode, no other cleanup actions can be performed.

Results of cleanup actions are displayed in the # Found section on the Design File Cleanup dialog box´s General tab, as well as in MicroStation´s status bar.


Apply

Accepts the settings and searches the design file for duplicate elements, overlapping elements and/or gaps between elements.

Done

Closes the dialog box when you have finished your cleanup actions.

File > Load Settings

Opens the Load Cleanup Settings dialog box, which is used to load previously saved Design File Cleanup settings.

File > Save Settings

Opens the Save Cleanup Settings dialog box, which is used to save the current Design File Cleanup settings to a file which can be loaded later.

File > Default Settings

Restores the default settings for Design File Cleanup

Data Cleanup -Roadway Cadd Support Method
Roadway Cadd Support recommends using Data Cleanup for deleting Duplicate elements




Chapter 5 :  Roadway cadd suPPort rESOURCES

Overview


CADD Video Tutorial List

The following is a list of Video tutorials available for your use:

1. Workspace Update & Existing Ground x-sections

2. X-Section Layout (XPL)
3. Iplot organizer – XSEC
4. NCDOT seals on PHM
5. Microstation UPF Creation
6. RD_AutoXD
7. Referencing -  Basic
8. Referencing – Interactive Models
9. Referencing – Live Nesting
10. RD_Grid
11. Limits of Constructions
12. Limits of Construction (Plan Labeler)
13. Profiles Exist & Prop Layout
14. Backup Netscape Email
15. Design File Generator
16. Mapdrive Fix
17. Pdf Creation with Microstation



Roadway Website Help Tools
 Roadway Q & A Forum




Roadway Index


 Criteria Files

Roadway User Database Request Forms


Roadway User Database General Information

 

CADD Request Form


Software Request Form



Hardware Request Form


Plot Request Form



Tip Folders Request Form


Employee Request Form 

Chapter 6 :  Common  cadd Issues

This a list of common CADD issues. Help for other issues can be found on the Roadway Web Page in the locations showed in Chapter 5 Roadway CADD Support Resources.
1.  Issue with Microstation not working correctly for example just trying to draw a line.

The common fix is to delete your old UPF and create a new one see the Help on the Microstation UPF Creation video tutorial.

2.  Issue with Geopak not working correctly for example Plan View Labeler gives you an erroneous station.

The common fix is to delete your resource files.  The procedure is as follows:

 1.  Get out of all Microstation files

 2.  Go to S:\Share\rd_InternalApplication\RD_DelRSC

 3.  Double click on RD_DelRSC.BAT

 4.  Get back into your Microstation and Activate Geopak and reset

      your Cogo Geopak User Preferences.

3.  Issue with certain elements plotting incorrectly using Iplot Organizer for example R/W symbols.

The common fix is to update your iplot driver.  The procedure is as follows:

1. Get out of all Microstation and iplot organizer files.

2. Go to S:\Share\rd_InternalApplication\RD_Iplot_Fix

3. Double click on iplotdrvk.exe

4. Unzip this folder to complete the process.

Note: The latest version Design File Generator (2.04.11 or above) creates design files using this naming convention. 








Note:


One thing to make sure you are aware of, anything that you might have saved in your workspace will be DELETED! Never save anything in your workspaces as this application will delete everything in there that is not suppose to be in there.





Note: Do not put dashes in the Tip Number and do not combine the Type and Description together for example U-2547_rdy_ps04.dgn





Open the U2547_rdy_typ.dgn design file and verify you are in TOP VIEW. 





Typical Section Created Manually





From the RD_DSN Tool Frame pull off the RD_MdLapps Tool Family and select the Typical Section Generator Tool Box








Note:


Check on the mirror tab to draw a symmetrical typical.  Check off to draw a non-symmetrical typical.





Populate the dialog boxes as shown





Step 1.  Lane Configuration





Step 2.  Pavement Depth                                                              





Populate the dialog boxes as shown





Step 3.  Shoulder Definition





Populate the dialog boxes as shown





Step 4.  Ditch Definition





Selecting the type of facility draws your ditch as shown in the Roadway Design Manual Section 1-2A. Set to Local for the Right ditch





Selecting CUSTOM gives you the ability to customize your ditch definitions. Populate the Left Ditch as shown with settings on the right.








Step 5. 


Draw the Typical





Step 6. 


Dimensions the Typical 











Notes:  


The typicals are drawn in consecutive order from top to bottom.


The UNDO Button will Undo All changes, not just for the typical you are currently working on.





Notes on Scaling a Typical:  


(A.)  Use the Drop tool box 


(B.) Check off Dimensions 


(C.) Select the entire typical using the Element Selector    (D.)  Scale your typical up or down





Finished Typical drawn with Typical Section Generator





Exercise 2: Draw the following typical using Typical Section Generator.  Use the pavement design from the above example.





Typical Section Created Manually





Close the U2457_rdy_typ.dgn design file.





Open the U2457_rdy_psh_lay.dgn design file.





Step 1.


Select the References Tool Box from the Primary Tool Family





Step 2.  


After the dialog box opens select Tools then Attach








Step 3.


Choose the u2547_ls_pml.dgn design file.





Step 4. 


Set your attachment method to Coincident World.  Then select OK to attach the file.








Note:  


The attachment method for design files needs to be set to Coincident World. 





Exercise 3: Attach the following files shown below to the U2457_rdy_psh_lay.dgn design file:





U2547_rdy_ss.dgn


U2547_rdy_row.dgn


U2547_rdy_dsn.dgn


U2547_ls_hyl.dgn


U2547_ls_utl.dgn


U2547_ls_sue.dgn


U2547_ls_prl.dgn


U2547_ls_bln.dgn





Note: 


You may also select multiple files at once when attaching them to your design file.





Reference Files can also be attached with the Drag & Drop Method from Windows Explorer.





Close the U2457_rdy_psh_lay.dgn design file.





Note:


The interactive method will allow you to key in your logical name when attaching the reference file. This is the only thing that should be changed. The Nested Attachments should not be changed.





Open the U2457_rdy_pfl.dgn design file.





Step 1.


From the Geopak Road Tool Frame select the Plan Preparation Tool Family then select the Draw Profiles Tool Box





Step 2.


Put in RDY for your Job Number and L for the Chain 





Step 3.


Select the Dialog Profile Cell Control icon





Step 4.


After Profile Cell Control Dialog box opens, choose the top button as shown on the left.


Populate the Place Profile Cell Dialog Box as shown on left except use 550’ for the elevation. Then place the profile.





Result of Step 4. 





NOTE:


There are various methods of placing place the cell.  Some may place it directly on a profile plan sheet while others may place anywhere in the file and work on their profile afterwards.








Profile information is added here.





Step 5. (Prepare Settings for Existing Ground Profile)


Select the Surfaces tab





Set the Tin File to u2547_ph_tnp_040525.tin





Set the Method to Triangles





Set the Display Setting to By Feature. 





Click on the Paint brush to set the Feature to 50 Exist V PFL Vertical Profile Draw Box as shown below. (Make sure you are reading from NCDOT ddb file).





Step 6. 


Verify your station and settings then Add Surface Settings





Step 7. 


Saves your Existing Profile Settings in COGO











Existing Ground profile will be plotted out similar to the one shown below.





 Step 1.  (Prepare Settings for a Proposed Profile)





Select the COGO tab





Set your Profile name to LPRO





Set the Display Setting to By Feature 





Click the Paint brush Set the Feature to 50 Prop V PFL Roadway Grade Draw Box





Set your Options for General  as shown on the left for  the VPI option toggle on VPI & Grade Labels.











Step 2. Draw the Proposed Profile





Set your Options for VC as shown on the left.





Add your Cogo Profile Settings





Close 








The Proposed profile will be plotted out similar to the one shown below.





Exercise 5: Draw an existing and proposed profile for Chain Y.





Close the U2457_rdy_pfl.dgn design file.





Open the U2547_rdy_dsn.dgn design file.





Step 1.


On the NCDOT_DDB Tool Frame select the Alignment D&C Manager Tool Box.





Step 2.


Path to the option for a 50 Scale English Proposed  Horizontal Alignment and select this option. 





Step 3.  


Next select Draw Plan & Profile 





Step 4.


Select jobrdy.gpk for the Job.





Step 5.


 Set the Operation to Chains.


  


Step 6.


Verify what options you want drawn are checked on. 





Step 7. 


Verify the Label Scale has been set to your desired scale in this example 50 is the setting. 





Step 8.


Now proceed to selecting the chain you want drawn in the design file, for this example use L.





Step 9.


Set the Operations to Stationing.





Step 10.


Verify what options you want drawn are checked on. 





Step 11. 


Verify the Label Scale has been set to your desired scale in this example 50 is the setting.





Step 12.


Select the chain you want to station, for this example use L.





Close the U2457_rdy_dsn.dgn design file.





Exercise 4: Draw and Station Chains Y, Y1, Y2





� EMBED Word.Picture.8  ���





1. Station Tick Marks





2. Curve Data





3. Station of Chain





4. Line Direction Label (Bearing)





Open the U2547_rdy_xsc_l.dgn design file.





Step 2.


Populate the dialog box as shown below be sure to set the Plan Dgn.





Step 1.


From the Geopak Road Tool Frame select the Cross Section Tool Family then select the Limits of Construction Tool Box





Step 3.


Set the Level name for the Existing Ground Line and Proposed Finish Grade





Step 4.


Set the Level name for the Construction Limits by right clicking in black area then selecting dialog.  Check on Place Construction Limit. Next change the setting to Prefix\Suffix.





Cut LVNAME = Prop SS Cut Line


Fill  LVNAME = Prop SS Fill Line


Transition LVNAME= Prop SS Transition Line





LVNAME = Exist XS Ground Line








LVNAME = Prop XS Finish Grade Earthwork


LVNAME = Prop XS Subgrade Earthwork








Note: 


Due to Current limitation of Geopak only allowing one level for the cut or fill use the Prop SS Cut Text level name for both the Left and Right.





Step 6. 


Select Apply to draw the Limits of Construction in the U2547_rdy_ss.dgn file.





Step 5.


Set the Parameters for the Construction Limits Text by clicking on Parameters.





Open the U2457_rdy_psh_lay.dgn design file and turn off all Reference files except U2547_rdy_dsn.dgn.





Step 1.  Retrieve a 50 Scale Plan Sheet Cell





From the NCDOT_STDS Tool Frame pull off the NCDOT_DDB Tool Family and select the DESIGN SHEET D&C Tool Box








Select Plan Sheet then set your scale to 50





Step 2.  


Place the Plan Sheets Cell(s)





Note:


Rotate your view for each Plan Sheet before placing each individual sheet.





Note:


Use Rotate View by Two Points to rotate the view.





Close the U2457_rdy_psh_lay.dgn design file.





Step 3.  Clip the Plan Sheet





Open the U2457_rdy_psh_04.dgn design file. All Reference files have been referenced for you for the purpose of the class.





Note: 


This is the actual Level Name to be used for the Matchline & Clip Elements shown above.





Note:


Matchlines are drawn Perpendicular to the alignment at an Even Station We recommend using a station length of 1400’ between the two matchlines.  Regardless of the station length used be sure your plan sheet and profile sheets use the same station length when cutting your sheets.





Step 3-A. 


Drop the Sheet Clip Boundary Cell














Step 3-B.  


Open the References Dialog Box





to clip the reference files.





Step 3-C.  


Select all your Reference Files then Use Clip Reference 





will set you up for failure when plotting.  Do not use.





Note: Using Clip Mask            





Step 3-D.   


Set it to Element to clip using the Sheet Clip Boundary Cell.   This setting will also allow you to clip the reference files dynamically (On the Fly) by using the MicroStation “modify” button.





Note:


The Geopak Plan & Profile Sheet Layout Tool shown below is another method for laying out Plan Sheets.  The help files are on the Roadway Web Page are being updated to our current practice. 





From the Geopak Road Tool Frame select the Plan Preparation Tool Family then select the Plan Profile Sheet Composition Tool Box








Close the U2457_rdy_psh_04.dgn design file.





Step 1.


Open Iplot Organizer then cancel out of first dialog box.





Note:  Be sure not to open the Microstation J version of Iplot Organizer





Step 2.


Set the Printer you will be using.








Step 3.


Drag and drop the Plan Sheet Design File(s) into Iplot Organizer





Note:  


This method will only work with design files that contain only one Sheet Cell. Profile and typical design files usually contain more than one Sheet Cell in the same design file; therefore this method will not work unless you use the “profile” set file.  The sheets must be placed in Top view in order from Top to Bottom and then from Left to Right (shown below).  After the files are in iplot organizer you will need to change the plot name to what you need. Another method for using iplot organizer will be shown later during the XPL section of the class.





Step 4. 


Select your Settings File





Note: Path for Settings file is C:\NCDOT_V8_WORKSPACE\ROADWAY_STDS\English\plot\FullSize SET 





Step 5. 


Select Close on the dialog box and the settings will be applied. 





Step 6.


Be sure to select SAVE and save the file as u2547full.ips





Exercise 6: Create a new Iplot Organizer half size set using the same design files.  Save file as u2547half.ips.





Open the U2547_rdy_pat_y.dgn design file.





Step 1.


From the Geopak Road Tool Frame select the Cross Sections Tool Family then select the Draw Patterns By Station Range Tool Box





Step 2.  


Populate the dialog box below to set the pattern line parameters.





Step 2A.  


Select the pattern line type





Step 2B.  


Right click in the Level Symbology field and select Dialog to set the level symbology.





Step 3.  


Draw the Pattern Lines





Note:


After the additional (Once) X-sections pattern lines have been placed, the pattern lines placed by Station Range should be evaluated for proximity to them. If the Station Range pattern line is within 10’ (+/-) of an additional (Once) pattern line, then the Station Range pattern line may be eliminated.  The additional (Once) pattern line should always take precedence.








NOTES ABOUT PATTERN LINES:





Pattern lines are normally drawn at Even 50’ station increments or a station Increment as determined by project situation.





Horizontal Control Points (ST, TS, PT, PC, etc.)





Use the Once Setting for the following:





All pavement transition points for instance any place the pavement widens or narrows should be picked up with an additional pattern line.





Centerline of box culverts or large streams  





Bridge Ends





Retaining Walls





Ends of Radius at Intersections : At both  Mainline and 


      Y Lines


Mainline & ramp gore area ties


 











Step 4.


Close the U2547_rdy_pat_y.dgn design file and open the U2547_rdy_xsc_y.dgn design file.





Step 5.


From the Geopak Road Tool Frame select the Cross Sections Tool Family then select the Draw X-Section from Surfaces Tool Box





Step 6.


Set your XS CELLS settings





Verify you are on the XS CELLS Tab





Select RDY for the Job Number 





Select Y for the Chain





Change from By Station to By DGN File





Set the Design File to u2547_rdy_pat_y.dgn





Toggle on Levels





Set Level Name to Pattern 1





Step 7.


Set your Surface Settings then draw the X-Sections





Select the Surfaces tab





Right click in the Level Symbology field and select Dialog to set the level symbology as shown in 2A below





Toggle on Elevation and change the settings as shown in 3-A below 





Toggle on Void  to change settings as shown in 4A below





Verify the Type is Line





Set your TIN File to u2547_ph_tnp_040525.tin





Add the Surface





Draw your X-Sections





Existing Ground X-Section





Void Line Settings





Elevation Settings





Existing Ground Settings





Note:  


The distance in the X-Section design file should match the distance in your criteria file





Step 9.


Load the Cri_Y.inp criteria file to create the proposed X-Sections.








Step 10.


Close the U2547_rdy_xsc_y.dgn design file and open the U2547_rdy_xpl_y.dgn design file.








Step 11.


From the Geopak Road Tool Frame select the Cross Sections Tool Family then select the Cross Section Sheet Composition Tool Box











Step 12.


Set your X-Section Design File Parameters as shown:











Set to XS DGN





Set to 5/10 Scale (75’ Left or Right)





Select the X-Section U2547_rdy_xsc_y.dgn





Step 13.


Set your XPL Design File Parameters as shown:











Set to Sheet DGN File





Select the X-Section U2547_rdy_xpl_y.dgn





Uncheck the Detach Existing Sheets before Processing





Change to One Sheet Per Model





Note: Verify your levels are not on the default level





Step 14.


Set your Sheet Labels as shown:











Set to Sheet Labels





Set the sheet parameters





Verify your Bar Scale settings











Step 15.


Uncheck Digtal Interplot:








Set to Sheet Labels





Set the sheet parameters





Verify your Bar Scale settings





11. Set to Digital InterPlot





Verify it is Unchecked





Layout the XPL Sheets








Step 16.


Click on the Model Icon to Navigate through your XPL Sheets  or use the Model Navigator





Double Click to go to Sheet X-1





Fit View








Step 1.


Open Iplot Organizer and cancel out of first dialog box.


Note:  Be sure not to open the Microstation J version of Iplot Organizer





Step 2.


Set the Printer you will be using





Step 3.


Create Plots.  Under Iplot Organizer go to File then Create Plots.





4A.  Add the U2547_rdy_xpl_y.dgn to the Input files field





4B.  Choose your Settings File 


       


Path for Full Size use


  C:\NCDOT_V8_WORKSPACE\ROADWAY_STDS\English\plot\FullSize SET 





Path for Half Size use





C:\NCDOT_V8_WORKSPACE\ROADWAY_STDS\English\plot\HalfSize SET\





4C.  Verify all your info has been set, now select OK and the     settings will be applied.





Step 4.


Populate the Create Plots dialog box





Step 5.  Be sure to select SAVE before exiting.





NOTE 1: You must be in Top View to place a Work Profile.





NOTE 2: (Point of Reference) A 50 scale Profile Sheet dimensions approximately 1500’ x 1025’





Step 2.


Select a scratch level to draw a block then on your Main Tool Frame select the Place Block Tool  Box





Step 3.


Place a block around your profile or in the Key-in text field key in dx=6000,1025 .








Step 4.


On your RD_MDLapps Tool Frame select the RD_GRID Tool  Box








Step 5.


Set your scale to 50





Step 6.


There are three options for creating a work profile in this example we will use By Rectangular Element.














Step 7.


Select the Rectangular Block drawn in Step 2





Finished Work Profile





Setting an active angle


Placing Text at an active angle


Rotate by 3 Points


Rotate by Element


Rotate to Top View 





Close the U2547_rdy_pfl.dgn design file.





Toggle button to display/not display fill areas.





Toggle button to relative element weigh or all element weight is displayed as 0.





Can be used with or without a fence. Mostly used to copy an element or a fence area from a file model to the active file model. Place a fence. Data Point on the screen to accept the fence area to copy. Click on DP in Same Location button to copy to same location. Same as key in “ DL=0,0”.





From the RD_DSN Tool Frame select the RD_VBA Tool Family then select the XS Movie Navigator Tool Box





From the RD_DSN Tool Frame select the RD_VBA Tool Family then select the Model Navigator Tool Box





Note:


After the application has been loaded, the current design file name and the current active model name are displayed.








2.  Drop Down Combo Box





3. Navigation Buttons Box





4.  Automatic Mode 





Note: that the Model Open and Close Speed setting is in seconds. Fastest speed is 1 second between models. Slowest speed can be set to 10 seconds between models.





From the RD_DSN Tool Frame select the RD_VBA Tool Family then select the SNAP Tool Box





Initial State








Note: Double clicking on a file will also move the file from one list to the other list.





Once completed, then a log of the event is displayed to the right of the GO button.








For each file in the list to be processed, the program will open each file and scan for a point on level "Sheet North Arrow Point CELL". The newer plan sheet cells as of February 26, 2007 will have this point located in the upper right corner.








If the file is read only or is opened, then the program will go to the next file on the list.


If the new plan sheet cell is still a cell, complex status has not been dropped, then the program will drop the complex status of the plan sheet cell once, and then continue to scan for the north arrow point.


If the new plan sheet cell complex status has already been dropped, then the program will automatically scan for the north arrow point.


If the north arrow point is found, then the appropriate north arrow cell is placed on the point once. Rotation of the north arrow is to North, or top view. The file is then saved.








If the north arrow point is not found, then no north arrow cell is placed.


The file is then closed and the program goes to the next file on the list until all files have been processed.








Note: If the Geopak Plan and Profile Sheet Layout program is used to create the plan sheet files, for clip sheets option, use "Rotate View" for plan sheets and for profile sheets, use "Rotate Reference".








Element Selection pop-up menu





From the RD_DSN Tool Frame select the RD_VBA Tool Family then select the Copy Level Name to Clipboard Tool Box





Overview


This program copies the level name of any selected element into the system's clipboard. Since the level name is a text string, any application like UltraEdit, NotePad, Word, Excel, Microstation Word Processor and key in field, some Geopak processes and many more that uses the system clipboard to store and retrieve data, can use this feature. In Roadway, in our input files, like Criteria and Earthwork inputs, requires users to manually key in level names. This tool should help with efficiency and accuracy.





Step 1.


Select the Microstation graphical element Prop Geopak Pavement Shape Dependent





Note:


The prompt field confirms the level name of what was selected. Also at the same time, the same level name is being copied to the system's clipboard and stored. there. opied. 





Step 2.


Open the application you want the level name copied to. For this demo, open the Criteria input file named Cri_Y_for clipboard.inp in UltraEdit and paste the level name in this file as shown below. 





can also be used to paste the level name into any of the applications.








Note:





Note:  If you select a cell element, before complex status has been dropped, it will store the cell name. That's because a cell can have more than one level name. 


 





Step 3.  To END the program just reset with the right mouse button or choose another Microstation tool.





Note: Refer to �HYPERLINK "https://inside.ncdot.gov/stage/connect/policymemos/cm_cd2003_08_25.PDF"��Centerline Coordinate List Memo�, August 25, 2003 on the Roadway Web under Cadd Memos








Overview


The Centerline Coordinate List Program is broken out into three major components.


Set COGO Information 


Create Centerline Coordinate List 


Create Centerline Coordinate Sheet 








Optimal Settings for Geopak COGO User Preferences





ENGLISH





METRIC





Note:  The differences between the station formats and output accuracy in stationing and angle depending on the Unit System used. This is a direct correlation to the preferences used in NCDOT Roadway plans.








Initial State of the Centerline Coordinate List Program








Note:  Once the Job Number, Chain, and Increment distance have been selected, the Beginning and Ending Station fields are automatically populated.











Note:  As an added feature, if either of these two labels is clicked on, the beginning and ending stations are reset back to the original default value.








An Excel Centerline Coordinate List is generated when the CREATE button is Clicked.








Note:  The Program prompts the Designer if additional Chains are to be appended to the list.








Note: The Job Number combo box has changed color to red and it is now locked.


 .








Error Messages





Note:  There are a series of tests the program goes through at this stage. Three of which are considered "critical" and will exit the program completely. The series of tests are performed in this order with the corresponding error and action to fix message.








Critical error raised if NCDOT V8 Workspace not configured and set.�








Critical error raised if the Excel template file used in the program is not found.�








Critical error raised if the Excel spreadsheet file has been terminated when the program is going to write to it.�








Error raised if the chain stationing is not in the correct order.�








Error raised if the beginning chain station is not within the chain.








Error raised if the ending chain station is not within the chain.











Error raised if the beginning chain station is not an even station.








Warning message raised if the beginning chain station is not an even 100 station.�








While the Centerline Coordinate List (XY_COORD_L) is being generated, the Centerline Coordinate Sheet (Centerline Coordinate Sheet) is also being generated. There are two sheets with a maximum of 820 point numbers.








Note: The "Easy" print buttons have been created for Roadway Design prints only with the Centerline Coordinate Sheet.








Before closing, the spreadsheet, Designers are prompted to save the generated spreadsheet file. If the spreadsheet is to be saved, then save as an Excel (XLS) file in the \\Roadway\Proj folder.








Step 1.


In a Microstation file go under Utilities then Data Cleanup





Step 2.


Select the Duplicates Tab 


Set the Action to Delete


Check on Level to Match


Select Apply





The are many listed resources are available to aid you in troubleshooting any CADD related issues.   In the words of the caveman  “How about doing a little research next time?” in order to see what help is available. Check with your Cadd Representative; if you still don’t have an answer open the Roadway Database and send us a Request Form and we will be glad to help you out.





Note:  


We are continually working on updating and creating other video tutorials.  The information contained within these video tutorials is current as of the time they were created.  





ROADWAY WEBSITE





Desktop Shortcut





Roadway Support Request Panel





Main Panel





Roadway Database





The RdyUser database is in the first beta testing phase with four design squads currently reviewing the product.  We expect to have the next beta version ready for testing within all of the Roadway Design unit by the end of these class sessions and hopefully in full production by the end of June


2007.





The primary purpose of the database if to present to our users more of a "Central Location Approach" to Cadd Support within Roadway Design.
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